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1 Foreword

1.1 Notes on the documentation
This description is only intended for the use of trained specialists in control and automation engineering who
are familiar with the applicable national standards.
It is essential that the documentation and the following notes and explanations are followed when installing
and commissioning the components. 
It is the duty of the technical personnel to use the documentation published at the respective time of each
installation and commissioning.

The responsible staff must ensure that the application or use of the products described satisfy all the
requirements for safety, including all the relevant laws, regulations, guidelines and standards.

Disclaimer

The documentation has been prepared with care. The products described are, however, constantly under
development.
We reserve the right to revise and change the documentation at any time and without prior announcement.
No claims for the modification of products that have already been supplied may be made on the basis of the
data, diagrams and descriptions in this documentation.

Trademarks

Beckhoff®, TwinCAT®, EtherCAT®, Safety over EtherCAT®, TwinSAFE®, XFC® and XTS® are registered
trademarks of and licensed by Beckhoff Automation GmbH.
Other designations used in this publication may be trademarks whose use by third parties for their own
purposes could violate the rights of the owners.

Patent Pending

The EtherCAT Technology is covered, including but not limited to the following patent applications and
patents:
EP1590927, EP1789857, DE102004044764, DE102007017835
with corresponding applications or registrations in various other countries.

The TwinCAT Technology is covered, including but not limited to the following patent applications and
patents:
EP0851348, US6167425 with corresponding applications or registrations in various other countries.

EtherCAT® is registered trademark and patented technology, licensed by Beckhoff Automation GmbH,
Germany

Copyright

© Beckhoff Automation GmbH & Co. KG, Germany.
The reproduction, distribution and utilization of this document as well as the communication of its contents to
others without express authorization are prohibited.
Offenders will be held liable for the payment of damages. All rights reserved in the event of the grant of a
patent, utility model or design.
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1.2 Documentation issue status
Version Comment
1.1 Chapter revision:

Downloading the TC3 Motion Designer 2.1; Installing the TC3 Motion Designer 2.2; 
Creating a new project 2.3; Saving a file 2.3.1; 
Opening a saved file 2.3.2; Creating a DC link 2.4; Load cases 4.1; Settings 4.1.1;
Motion profile 4.2; 
Transmission element 4.3; Controller 4.6 ; Error messages 7.4
Restructured chapters:
Service packs and upgrades 2.3; Gear unit 4.4; Motor 4.5; 
Bill of materials and data sheet (axis) 4.7; Setting the language 7.6; 
Service packs and upgrades 7.7
New chapter:
Importing a CSV file 4.2.1; Component selection 4.4; Gear unit and motor 4.5

1.0 First edition
0.1 Internal version

1.3 System requirements
Before installing or using TC3 Motion Designer from Beckhoff, ensure that your computer meets the
minimum system requirements for this software product.

Computer component System requirement
End device and processor 1 GHz or faster
Main memory 1 GB RAM (1.5 GB RAM for execution on a virtual machine)
Hard disk 4 GB freely available memory space on the hard disk

Hard disk drive with 5,400 rpm
Screen All common screen resolutions
Graphics card DirectX9-compatible graphics card with a resolution of 1024 x 768

pixels or higher
Operating system Microsoft Windows 7 or higher
Microsoft Visual Studio version Full installation with Microsoft Visual Studio Shell 2010

Update versions with Microsoft Visual Studio Shell 2012 or 2013
Others ---
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2 Installation and getting started

2.1 Downloading TC3 Motion Designer
To download the TC3 Motion Designer proceed as
follows:
• Open the Beckhoff website (http://

www.beckhoff.de)
• Open the "Motion" section
• Open the "Software" section

◦ Click on the folder: 
“TC3 Motion Designer”

◦ A download area opens
• Click on the required file (1)

◦ The download 
cart opens

◦ Click on: “Start download”.

Download options (2)

Version Description
TC3 Motion Designer (update) – version 1.1.0 The update integrates into an existing 

Visual Studio Shell environment.
TC3 Motion Designer (full installation) – version 1.1.0 In addition, the full installation includes a Visual Studio Shell 2010.

2.2 Installing TC3 Motion Designer
Installation process Target language of the installation
Download the installation file (“Downloading the TC3
Motion Designer”) [} 7] from the Beckhoff website
(www.beckhoff.de).
Start the installation process by double-clicking on the
downloaded setup file (can be found in your download
folder).
A new menu window opens (see screenshot below).
• Click on "Run" (1).

Now select the target language for the installation
program in the menu window (see screenshot
below).
• Click on the language menu (1). 

A list of all available languages appears.
• Select your target language.
• Confirm with OK (2).

http://www.beckhoff.de
http://www.beckhoff.de
http://www.beckhoff.de/
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Agreeing to the license agreement Entering the user information
In the next menu window, you have to agree to the
license terms of Beckhoff Automation GmbH & Co. KG.
• Accept the license agreement by ticking the check

box (1).
• Confirm with OK (2).

To install the software, you need to provide your
user information (see screenshot on the left).
• Enter the required data (1).
• Confirm your entries by pressing the Next button.

Printing the license agreement!
If required, click the "Print" button to print the license agreement from Beckhoff Automation GmbH &
Co. KG for the TC3 Motion Designer.

Creating your user information!
In order to keep your administrative effort to a minimum, we recommend using your computer name
as your user name. It can be found in the Control Panel → System.

Preparing for the installation and the installation process
Once the user information has been confirmed, 
the TC3 Motion Designer setup program starts
preparing the installation.
The green progress bar shows the progress of the
preparation. Once the progress bar has reached
100%, the installation commences.

TC3 Motion Designer is now installed on your
computer.
The green progress bar shows the progress of the
installation process. Once the progress bar has
reached 100 %, the installation of TC3 Motion
Designer is complete.

Canceling the installation process!
The installation process can be canceled at any time by pressing the Cancel button. To repeat the
installation proceed as described above.
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Completing the installation process

Press the Finish button (1).
TC3 Motion Designer was successfully installed on
your PC.

2.3 Creating a new project
This section explains how to create a new TC3 Motion Designer project.

Open Microsoft Visual Studio via the Windows Start menu.

Specifying the basic settings
First, specify the basic settings for your TC3 Motion
Designer project. Basic settings consist of fixed user
information, which later appears in your report
[} 42]. The settings can be edited at any time.
• Open the "Tools" menu in your Microsoft Visual

Studio environment.
• A further menu window opens. Click on "Options".

In the "Options" menu window, left column, click on
TwinCAT → Motion → Motion Designer (1; shown in
blue).
In the input window (2) you can now specify your
basic settings.
• Confirm your selection with OK.

Microsoft Visual Studio version from 2013!
@@From version 2013, the "Tools" menu in the Visual Studio environment is replaced by the 
"Extras" menu!
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Creating a new project Entering the project information
Open the "File" menu in your Microsoft Visual Studio
environment (1).
• Click "New" (2).

A new menu window opens.
• Click "Project" (3).
Note: After creating a new project, a context menu
appears for Creating a new DC link [} 13].

Now assign a project name and the default path in the
menu window (1) "New project".
To set the default path:
• Click on "Browse…“
• Create a destination folder for your TC Motion

Designer projects.
The standard path you created (C:\temp, for example)
is saved for future projects.
• To apply the project information:
• Confirm with OK (2).

Opening the Solution Explorer
If the Solution Explorer does not appear automatically
in the user interface once you have created your
project, call it up via the "View" menu item (1).
You can adapt the Solution Explorer to your personal
user interface. To do this, press and hold the yellow-
colored bar with the left mouse button. A cross-
shaped image appears (2). You can now pin the
Solution Explorer to the desired location in your
interface.

View in Solution Explorer
Once you have created your project, the TC3 Motion
Designer project is displayed in the Solution Explorer.
Create a DC link in the next step.
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2.3.1 Saving a file
This section explains how to save an exported file in the Visual Studio environment. This provides a
mechanism for making projects that have already been processed available in other current projects.

In this chapter, you will learn how to export individual axes or DC links, so that you can use them again in
future projects.

Saving a DC link and an axis
TC3 Motion Designer has an option for saving your DC links and axis projects.

Saving DC link:
• Enable the DC link 

(left-click on DC link, blue color).
• Right-click on the selected DC link. 

A further menu window opens.
• In the menu window click on: 

"Save DC link as…" (highlighted in yellow).

Saving an axis:
• Enable the axis 

(Left click on the newly created axis in the Solution
Explorer [} 9]; blue color).

• Right-click on the selected axis. A further menu
window opens.

• In the menu window click on: 
"Save Axis as…" (highlighted in yellow).

A saved axis can also be imported into other
configurations.

Specifying the storage location
After left-clicking on: “Save DC link / axis as…”, a new
menu window opens.
• Enter a storage location and a name (2).
Make sure the selected storage formats have the
following extensions:
• .TcDcLink (for DC links)
• .TcAxis (for axes)
Once a name and storage location has been specified
(2), confirm your selection with the "Save" button (3).
The DC links or axes you saved can be found under:
• temp → TwinCATMotionDesignerProjects (1).
You have successfully saved a file.
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2.3.2 Opening a saved file
This section explains how to open a saved file in the Visual Studio environment.

Opening a DC link and an axis
TC3 Motion Designer has an option for opening saved DC link and axis projects. Once the selected file has
been opened, you can edit your configuration.

Open DC link:
• Enable your TC3 Motion Designer project 

(Left-click; blue color).
• Right-click on the selected project. 

A further menu window opens.
• In the menu window click on: 

“Add Existing DC Link From File" (yellow color).

Open axis:
• Enable the DC link you created 

(Left-click; blue color).
• Right-click on the selected DC link. 

A further menu window opens.
• In the menu window click on: 

“Add Existing Axis From File" (yellow color).

Opening a DC link or an axis
• Left-click on: “Add Existing DC Link / Axis From

File”.
A new menu window opens.

• Select your DC link (.TcDcLink) or your axis
(.TcAxis) (2).

• Confirm your selection with the "Open" button (3).
The DC links or axes you created can be found
under:
• Settings → TC3 Motion Designer (1).
You have successfully opened a saved file.
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2.4 Creating a DC link
The DC link concept has the advantage that in multi-axis systems the drives can be coupled in the DC link,
so that they can exchange energy. 
Using this approach you can determine:
• the required feed-in power and
• any braking power that may be present in the DC link network.
@@Subsequently, the synonym "DC link" will be used.

Specifying the project properties

Before you can add a DC link, you have to specify your project properties. The project properties are
specific data referring to the project you created. This data is applied to your report. Creating a report
[} 42].

Procedure
• Right-click on your project.

A further menu window opens.
• Left-click on "Project Properties".
• Complete the information fields

Note:
You do not have to save the inputs separately. Any
information you add is automatically saved when you
exit the input window.

Adding a DC link Entering the DC link settings
• In the Solution Explorer right-click 

on the newly created TC3 Motion Designer project. 
A new menu window opens.

• Click on "Add DC Link" (1)

Supply (1): 
Here you can choose between 1- or 3-phase alternating voltage or a
direct voltage (DC) power supply (only for servo terminal EL72x1)
for your supply network.
Supply voltage: 
In the selection menu (2) you can set the unit for the supply voltage.
Possible units are V, mV or kV.
Product group (3): 
Here you can choose between the servo drives of the AX5000 and
AX8000 series and the EL72x1 servo terminal (only possible if a
direct voltage (DC) power supply was selected).
Confirm your DC link settings with OK (4).
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View in Solution Explorer
Once you have created your DC link, it is displayed in the Solution
Explorer.

Creating another DC link
To add a further DC link, repeat the above steps. The voltage set for each created DC link is
constant and can no longer be changed subsequently.

Notes regarding the supply voltage!
Information regarding permitted supply voltages can be found in the technical data for the AX5000
and AX8000 servo drives and the EL72x1 servo terminal. For technical data please refer to the
system manuals and other documentation. These can be found on the Beckhoff website at:
www.beckhoff.com.

http://www.beckhoff.com/
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3 User interface of the DC link
This chapter explains the user interface for the DC link.

DC link overview
This menu item provides an overview of all the
components created in your application, including a
description of the supply. This overview 
is only populated once you have dimensioned 
your axes and configured the load cases.

For further information on the components of your DC
link, move your cursor over the images under your
supply or capacitor module. If the information does
not appear immediately, move the cursor over the
images again and leave it there for a while.

Axis overview
This overview shows all the available application values (e.g. position of your load case or speed of the
used motors) in a coordinate system. The application values must first be selected in the pull-down menu.
The graphs show the time dependency of all application values and the motors used in a common time
base.

Selecting the application values:
The TC3 Motion Designer offers a wide range of selectable application values. Please check the
applicable application values, based on your processing steps, and depending on the application.
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Performance overview Operating elements for adding and removing
If your configuration is faulty (e.g. due to incorrectly
dimensioned components), the TC3 Motion Designer
reports an error.
This is shown as a red circle with a white exclamation
mark.
To see a short description of the error, put the cursor
for a longer period of time over the red circle. An
information box appears.
Reference for the nominal and application values:
• The nominal values refer to the DC link

configuration.
• The application values refer to all axes that were

created in the DC link.
The characteristic values are calculated
automatically. All components added to the DC link
serve as basis.

Use the + or - buttons to add components to your DC
link or remove components (e.g. in the event of
incorrect selection or configuration).
When is it necessary to remove / add
components?
• In case of an error message
• In case of incorrect dimensioning (brake resistor

too high)
• Incorrect component selection (different supply

module etc. is required).

Performance view
These performance data are then graphically
displayed in the performance view. The current
values and application values are displayed. In this
way, all settings can be visualized and double-
checked.

View of the added components:
When you have dimensioned your DC link, 
all existing components are listed. The order code along with a short description of the performance
data is displayed.
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4 Axis user interface
This section explains the user interface for the axis configuration.

Once you have created a DC link, an axis is simultaneously created in the Solution Explorer. Double-click on
the axis to open the user interface for the axis configuration.

TC3 Motion Designer loading duration!
When you activate TC3 Motion Designer by double-clicking on the axis, Microsoft Visual Studio
starts TC3 Motion Designer in the background. This process can take a few seconds. Please avoid
repeated double-clicking on the axis. Repeat the process, if the user interface fails to appears after
a while.

The TC3 Motion Designer user interface consists of the following sections:

Number Explanation
1 Selecting the application load case
2 Creating a motion profile
3 Selecting the transmission elements
4 Selecting the gear unit
5 Selection the motor
6 Selecting the servo drive
7 Viewing the bill of materials for the application with all components
8 Entering the emergency stop torque
9 Settings
10 Inertia and mass calculator
11 Installation position for the selected load case
12 Selecting the views (large view and section view)
13 Selection options for the different menu items

All menu items are explicitly described in the following sections.
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4.1 Load cases
This section provides basic information about the load cases available for selection in TC3 Motion Designer.
The different mechanical systems used in a machine require various data for calculating torques, speeds
and loads. TC3 Motion Designer offers different load cases for visualizing this information.

Overview of load cases
TC3 Motion Designer enables calculation of 7 different load cases.
Select the load case that matches the requirements for your application.

 You are currently on the first tab of the progress bar.
The activated tabs are highlighted in grey and show the icon for the
respective configuration step. A more detailed description can be found in
chapter: “The progress bar”. [} 40] The individual load cases are
described in more detail below.

Load case 1: Conveyor belt Load case 2: General
The conveyor belt load case enables calculation of a
range of drive configurations, from simple toothed
belt drives to complex belt drives with tension roller
and weight compensation.
This load case has low to medium 
requirements in terms of accuracy.
Usually a gear unit is used.

This load case covers all cases that are not specified
in more detail. The only parameter to be specified is
the driven mass inertia.
The settings areas for the general load case are the
same as for the more detailed specifications and
have no special characteristics.
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Load case 3: Pinion rack Load case 4: Rotary indexing table
This load case relates to exacting applications with
high precision requirements. Usually a high-quality
gear unit with reinforced bearings is used, in order to
be able to cope with high radial forces.

The rotary indexing table is also referred to as rotary
table or rotary switching table. The advantage of
servo drives is flexible and easily adaptable
graduation. A-centric masses are also taken into
account.

Load case 5: Spindle drive Load case 6: Crank drive
This load case is used for medium to high-precision
linear movements. The motor is usually coupled
directly to the spindle.

This load case is characterized by complex
mechanics, which directly transform the rotary
movements of the motor into a linear motion.

Load case 7: winder
This load case enables calculation of winding
processes with single-layer media (e.g. paper rolls) or
with several windings per layer (e.g. cable winch). 
The input coordinate is either the axis position or the
length of the material.
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4.1.1 Settings
Horizontal

This settings area is set as standard in TC3 Motion Designer. For
the selected load case the horizontal installation position is shown
first.

Vertical
The vertical installation position also takes into account the
gravitational constant.
This default value for this parameter is 9.81 m/s².

Complex
Compared with the horizontal and vertical installation positions, in
addition to the gravitational constant the complex installation
position can also take into account counterweights, counterweight
forces and inclination angles.
For all installation positions the input values can also be described
as formulas, which are automatically applied to the settings areas
as decimal numbers.
A more detailed description of the formula editor can be found on
the next page.
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Scientific view in the settings area

TC3 Motion Designer offers the option to select different load case views in the user interface.

This is the default view in TC3 Motion Designer. It
shows a photo-realistic diagram of the selected load
case, including all required dimensions.

Press the button (1) to switch to a scientific diagram.
This diagram includes all released forces and
moments.

Application of formulas in the settings area

TC3 Motion Designer offers the option to enter formulas for configuring a load case directly in the settings
area.

If the circumference of a basic body is given instead
of the diameter (1), for example, it can be calculated
with the
Formula:
200 / pi 

The TC3 Motion Designer now calculates the
diameter using the formula. It is represented as a
decimal number (2).

A formula table can be found in chapter: "Formula table" [} 46]
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4.2 Motion profile
This section provides basic information on the motion profile for a load case.

Once a load case has been selected and specified, a
motion profile can be created based on sections.
The motion profile illustrates curves along different
points. The profiles are specified and evaluated
based on certain rules.
Currently, only stop-to-stop movements are
considered.

Step 1

Adding a section
To create a profile, you first have to create a section.
• Open the settings area (1)

(Left-click on "Add")

Specifying the section
In the settings area you can now specify a section.

• Enter a name (1) for your section.
• Select the motion profile (2) for your section.
• Enter information on the positioning mode, position

and duration of the section (3).
• Confirm your entries with OK.
You have successfully specified your section.

Creating several sections!
You can create any number of sections within a motion profile. The sections may have different
distances/durations. To create a new section, repeat the procedure from step 1.
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Step 2

Display of motion profiles (trajectory)
Once you have specified your section, the corresponding profile is displayed. The profile shown illustrates a
trajectory.

The following process steps are shown:
• Position
• Velocity/speed
• Acceleration
• Jerk of the load case.

Further basic and section settings
The settings area can be found to the right of the process curves.

Under (1) enter:
• an initial value for your movement.
Under (2) enter:
• the positioning mode
• the position
• the duration
• the maximum acceleration
• the maximum deceleration
• the jerk of the load case
The setting options are described specific in step 1:
"Specifying the section".

Selecting the units!
All units used in the settings area can be changed via pull-down menus (to the right of the input
fields). When a unit is changed, the result is shown in the new unit.

Displaying the motion coordinate for the load case!
The motion coordinate and the 0 position are displayed in the motion profile for the load case.
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Step 3
If additional or modified process forces occur during the motion (e.g. the cutting force of a milling head), or if
the process mass changes (e.g. the transported workpiece is removed from the tool carriage), this change
can be reflected in the views. The changes are not tied to the motion sections. The input is time-dependent,
which means that additional time sections have to be added.

Selecting views
In addition to the trajectory view, TC3 Motion Designer offers two further views, which are described in more
detail below.

You can select the view in the selection bar (1).

Viewing the process sequences
Under the Process force and torque tab you can define modified forces or torques.

In addition, you can create several sections via the
section settings.
You can switch the view under the view tabs Process
mass and Inertia.
The following process steps are shown:
• Position,
• Velocity/speed,
• Acceleration of the defined motion,
• Process force,
• Process mass and
• Inertia

Import CSV:
A variable force can be imported as a CSV file.
• Assign a section name (1).
• Open the CSV import menu.

(Left-click on button 2)
• Select your CSV file.
• Confirm with OK.
The settings from your CSV file are shown in the
menu (3).
Note:
All data can also be supplied manually, if no CSV file
is available.

Configuration example for a CSV import!
Chapter 4.2.1: "Importing a CSV file [} 25]" illustrates a concrete example of importing a CSV file in
your TC3 Motion Designer project. The example is based on version V1.1.0 of the TC3 Motion
Designer and Microsoft Visual Studio Shell 2010.
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4.2.1 Importing a CSV file (configuration example)
This chapter illustrates the import of a CSV file. The individual sections build on each other and should be
followed sequentially! In addition, please note that it is only a sample configuration. Real projects may differ.

What is a CSV file?

A CSV file is used in the TC Motion Designer to import a simple data structure (table in Microsoft Excel,
characteristic values from a database) into an existing project. A prerequisite is that a project has already
been created in the Solution Explorer, and a DC link has also been created.

Our example is an actual customer project of Beckhoff Automation GmbH & Co. KG, in which a label
application process has been implemented.

The following must be observed:
• The first column specifies the time in seconds. Several data, e.g. 

velocity/speed → column 1, process mass → column 2, process force → column 3 can be added.
• The decimal separator (, or .) and number separator (tab, semicolon, etc.) can be selected as required.

Adding the CSV file in the TC Motion Designer project (under MS Visual Studio)
• Right-click on "Resource files".
• A new menu window opens.
• Left-click on "Add existing file" (1).

The CSV file "Application_Example_TCMD" (2) was
successfully added to the Solution Explorer.
It can be opened by double-clicking with the left
mouse button.

Preparing the CSV file for import into the motion profile
Next, add a new movement section:
• Click Add (1) in the motion profile.
• A new menu window opens.
• In the pull-down menu (2) select the

tab "File import" (3).
• Confirm your selection with OK (4).

Further information on creating a motion section!
For further information on creating and specifying a section please refer to chapter: 4.2: “Motion
profile [} 22]”.
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Importing and specifying the CSV file in the section settings
Please choose between the following import
options:
• position, velocity/speed or acceleration (1).
The difference is in the requirements for the
processing process for your application.
• Enter a name for your section.
The next step is the file import:
• Left-click on the button "File name" (2).
• The CSV file is now available for import.
• Confirm with OK.

After successful import of the CSV file, edit the
setting:
• ”Number separator”
Select semicolon instead of tab. The error message
should disappear after the setting was changed.
Note:
This selection is required because the format Comma
Separated Values uses semicolons to separate the
data fields.
The multiplication factor can take into account
different units:
• e.g. speed in rpm

Overview of the imported CSV file as movement section

When all settings have been
implemented, the imported CSV file and
its characteristic values are displayed
graphically.
You can customize the section settings
according to the requirements of your
application.
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4.3 Transmission element
Gear units from Beckhoff Automation GmbH & Co. KG are specified in section: 
"Gear units".

Once you have created and specified a motion
profile, you can select the transmission elements
required for your application. 
You can choose from the following elements:
• Belt drive
• Coupling
• Gear unit
• Gear rack
For information on how to add, remove or specify
transmission elements see step 1 below.

Step 1

Adding, removing or moving a transmission element
Once you have reached the Transmission element
menu item, a belt drive with the name 0 is created
automatically.
Depending on your, application you can select from
four different transmission elements, as described
above. In addition, you can add elements (1)
(elements are numbered automatically) or remove
elements.

Specifying the transmission element
Once all required transmission elements have been
created, you can specify the settings in the next step.
In this example (belt drive) the following setting
options are available:
• Diameter motor side
• Diameter load side
• Mass inertia motor side (including inertia

calculator)
• Mass inertia load side (including inertia calculator)
• Efficiency

Deviations from the setting options!
Please note that the variables in the settings area may change, depending on the choice of
transmission element. The setting options listed under step 1 "Specifying the transmission element"
only refer to the belt drive transmission element.
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4.4 Component selection

4.4.1 Manual selection
Pre-filtering of the components (gear unit and motor)
After pre-filtering, the TC3 Motion Designer suggests suitable motor and gear types.
The following component filtering options are available:
• Load:

Select whether your component should have a maximum load of less than 100%. 
For motors, an additional option is available: “mechanically compatible with the selected gear unit”.

• Manufacturer:
Select your gear type and the size of the gear unit.

Special features of gear units:
• Type:

Choose between angular and planetary gear units.
• Gear stages / gear ratio:

Choose the gear stages and the gear ratio.
Special features of motors:
• Requirements:

Choose between “hygiene-compliant”, “fan permitted” and “with holding brake”.
• Feedback system:

Choose between 18 and 23 bit single/multi-turn or resolver
• Wave definition:

Choose between smooth shaft (optionally with shaft sealing ring) or feather key (optionally with shaft
sealing ring)

Note:
For a 480 V DC link, the following option appears in the settings area: “Allow 400 V / 480 V Motors”.
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Selecting the components (gear unit and motor)
After pre-filtering, the available components are displayed in the selection list at the right of the user
interface (see screenshot below). The selection list contains specific technical data for the available motors
and gear units.
The green, yellow and red colors indicate the suitability of the components in relation to the previously
selected motion profile. Only select components that are highlighted in yellow or green should be selected!
Preparing a data sheet:
• Right-click on the selected component.

A new menu window opens.
• Left-click on: “Create data sheet”.
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4.4.2 Optimizer
Pre-filtering the components (gear unit and motor) with the optimizer

After the optimization, the TC3 Motion Designer
suggests suitable motor and gear types.
Activate optimizer:
• Then click on Show optimization settings. (image

on the left).
You have successfully opened the settings window
for the gear unit optimizer.

To use the optimizer settings, you must first enable them (1).
In the safety factor settings (2), you can select your desired nominal safety, as well as the maximum safety
of the components.

The gear filter (3) offers choices for the manufacturer and the gear type (see Manual selection [} 28]).
Activate your selection by left-clicking in the box.
Under the motor settings (5) first select whether the motor is subject to hygiene legislation and whether it
should have a fan or a holding brake.
In step (6) you now define:
• Manufacturer
• Feedback system and
• Wave definition
Once you have specified your motor, you can enter the optimizer settings (4):
• Speed and torque load of the transmission
• Priority of the above setting

The criteria in the selection list are weighted based on these priorities.

Finally, under step (7) you define:
• Mass inertia ratio
• Maximum speed and torque load
• Performance and price of your motor.
• Specify priorities for all settings.
You have successfully configured the optimizer for
the gear unit and the motor.
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Selecting the components (gear unit and motor)
Once you have made the settings in the optimizer, the appropriate components appear in the selection list
on the right of the user interface (see screenshot below). The selection list contains specific data of possible
motors and gear units, sorted by the optimization criterion.
The green, yellow and red colors indicate the suitability of the gear unit in relation to the previously selected
motion profile. Only select components that are highlighted in yellow or green should be selected!
Preparing a data sheet:
• Right-click on the selected component.

A new menu window opens.
• Left-click on “Create data sheet”.



Axis user interface

TE591032 Version: 1.1

4.5 Gear unit and motor
Once you have specified your components via manual selection [} 28] or the optimizer [} 30], you can
select them.
The image on the left shows the user interface of the gear selection; the motor interface is shown on the
right.
When you click the button: “Use no gear unit" or "Reset motor setting", a red warning triangle appears (see
image on the left), and the selection lists are hidden. 
When you left-click on the warning triangle, the optimizer starts a new selection list (image on the right), and
you can continue your configuration.

Gear unit and motor curve profiles

After the gear unit and motor selection, curves profiles of the components are displayed below. The profile
definitions are explained in more detail in this chapter.
Curve profile of the selected gear unit Curve profile of the selected motor

S1 – curve (green line):
Indicates the permitted mean drive speed and 
the rated torque at the output.
S5 – curve (red line):
Indicates the maximum drive speed and the
maximum acceleration torque in the form of
periodically intermittent operation. The gear unit
accelerates and decelerates periodically.
Application curve (blue line):
Indicates the speed and torque requirements for the
specified motion profile. The application curve must
always be in the range of the red S-5 curve (for gear
units) or the red voltage limit curve (for motors).

Nominal point (green square):
The rated point represents the rated torque at the
rated speed. This depends on the set operating
voltage.
Effective application point (blue square):
The effective application point is calculated from the
application curve including standstill periods. It
represents the mean speed and torque requirement.
This point must always be within the green S1 curve.
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4.6 Controller
This section provides basic information about selecting a servo drive in TC3 Motion Designer.

Once you have selected and specified your motor you can select your servo drive.
In our example we selected the servo drive
AX8206-0x00-0000.
Two new characteristic curves appear in the window
on the left of the user interface. The user interface
shows the required torques, converted to current.
Rated current controller:
Shows the continuous current of the servo drive. The
effective application point must always be below
black rated current controller limit curve.
Maximum current controller:
Shows the maximum current of the servo drive. The
blue application curve must always be below the
maximum current controller limit curve.
The selected servo drive and its specifications are
displayed above the characteristic curves in the user
interface.

Selection options

Selecting a servo drive based on the selection list
Suitable servo drives for your application are displayed for
selection in the window on the right of the user interface.
Left-click on the selected servo drive to activate the button
(highlighted in blue) and transfer the current curves into the user
interface.

Creating a data sheet and opening the documentation

• Right-click on the selected servo drive
• Left-click on: “Create data sheet" or
• Left-click on: “Open documentation”
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4.7 Bill of materials and data sheet (axis)
This section provides basic information on creating a bill of materials for your selected load case.

Additional definitions for components

For some components additional definitions can be specified. In our example we selected the AX8000 servo
drive as component.

Additional definitions:
• no definition (not defined)
• without TwinSAFE
• TwinSAFE (STO, SS1)
• TwinSAFE (17 drive-integrated safety functions)

Create data sheet, open documentation and step module

The image on the left shows the button "Create data sheet". When this button is activated (by left-clicking),
TC3 Motion Designer creates a data sheet for the previously selected component (see image on the right).
Additional buttons:
• Open documentation

The current documentation is opened
• Step models

Opens the current step model

In this example we selected a data sheet for the
AX8206-0x00-0000.
Each data sheet contains links to the respective
documentation or step modules on the FTP server.
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Create bills of materials

Step 1 Step 2
• In the Solution Explorer, select the axis/axes you

created.
• Right-click on the axis/axes to open the menu in

the bottom image.
• Select "Create bill of materials".

• Select the target language for your BOM.
• Confirm your selection with OK.

Step 3
A new window opens once you have selected the
target language. Specify your storage location in this
window.
TC3 Motion Designer now saves your bill of materials
at the specified destination. If Microsoft Excel is
installed on your computer, the file will be saved
in .xls format. If not, a CSV file is created. This can
subsequently be imported in Excel.

BOM misconfiguration

The TC3 Motion Designer shows any errors that were made during the configuration of the bill of materials
in the "Error Messages Window" (1) below the user interface.

Sample error message:
The selected motor/gear combination cannot be
installed.

Creating a documentation folder!
Starting with version 1.1.0, a documentation folder can be created, in addition to the bill of
materials. This includes all step models, documentations and BOMs that exist in the configuration.
To create a documentation folder, proceed as follows:
• Right-click on an element
• ”Create Documentation Folder”
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4.8 Emergency stop
This chapter provides basic information on the emergency stop features of your application.

Once you have fully specified your selected load
case, you can enter the emergency stop brake
torque. The precise specifications are explained in
this section.
The purpose of an emergency stop brake torque is to
protect against possible personal injuries. The aim is
for the application to come to a complete standstill
based on an adequately dimensioned emergency
stop brake torque, before persons can enter the
hazardous range of the machine / application.

The worst braking case The settings area
The peak values for velocity, braking distance,
braking time and braking energy shown under (1) are
worst-case scenarios.
The curves show the worst braking case. The curves
result from the set emergency stop brake torque.
The demarcation line (1) is a notional line to illustrate
the peak values of the individual graphs. This
boundary line does not appear in TC3 Motion
Designer view.

You can enter an emergency stop brake torque in the
settings area (2). Please note that the value you
enter must be lower than the maximum motor and
controller torque.
In the worst case, the result of the emergency stop
brake torque would be greater than the respective
maximum braking energy on the motor and load side.
We recommend setting the load-side braking
distance (can be calculated from the set emergency
stop brake torque) to mm. To change the unit, open
the drop-down menu (3) in the settings area and
select the required unit.

Saving your configuration!
Once you have dimensioned the emergency stop brake torque in the last step of the application
configuration in TC3 Motion Designer, you can save your project. For information on how to open a
saved project or created axes please refer to chapter: ”Opening a saved file [} 12]”.
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5 Tools and Symbols
This section provides basic information about tools and symbols in TC3 Motion Designer.

5.1 The inertia calculator
This section provides basic information on the inertia calculator.

The inertia calculator can be found in the settings
area (1) for all load cases that are available for
selection. The inertia values are application specific
(horizontal, vertical, complex).
The calculator provides a convenient method for
determining the moments of inertia of the load. The
calculated data are automatically transferred to your
settings area (1).

Activate the button (see image on the left) to open the
settings area for the inertia calculator.

Configuration of the inertia calculator

The inertia calculator has four main sections:
Display view (1): 
This window shows the selected body, including the variables to be
entered.
Results view (2): 
This area shows the calculation result. You can specify different
units, which are then mapped as decimal number or E-function.
Adding or removing bodies (3):
In this range you can add new bodies or remove bodies. The
preview shows the total volume, total mass and total mass inertia.
The units are taken from the results view (2).
Settings area (4):
In this area the properties of the body you added are calculated
taking into account all required parameters. 
The settings areas are structured as follows:

• body
• axis of rotation
• properties
• density and
• result.

Further details of the procedure can be found in section:
"Configuration example [} 38]".
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Configuration example
In this section we calculate a mass inertia for a drive roller (hollow cylinder) rolled from aluminum for the load
case Conveyor belt [} 18] as an example.

Step 1

Creating the load case
In the first step create the load case Conveyor belt.
Microsoft Visual Studio and TC3 Motion Designer
must be open. Furthermore, a DC link [} 13] must
have been created, and an axis must have been
added. Activate TC3 Motion Designer by double-
clicking on the created axis. Further information can
be found in section: "Activating TC3 Motion
Designer".

Step 2

Activating the inertia calculator
In the next step, activate the inertia calculator
according to the button shown at (1). Detailed
information can be found in section: "The inertia
calculator [} 37]".

After pressing the button, the input window for the
inertia calculator appears (see image on the left). The
default body is a cylinder (solid material). Step 3
explains how to change the body.
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Step 3

Specifying the drive roller
You can now specify your drive roller. To select the
basic body (in this case a hollow cylinder), open the
pull-down menu in the tab Settings → Body. A list
with various geometries opens, from which you can
select the basic body that matches your application.
Now you can create an axis of rotation, i.e. the axis
around which your geometry rotates. You can
distinguish between A- and B-axis. Now enter the
axis distance based on the center of the body and the
selected axis of rotation. In our example we select a
distance of [d] = 40 mm.
Next, enter the other properties of the geometry.
These include the outer [D0] and inner [Di] diameter
and the height [h] of the hollow cylinder.
In our example the hollow cylinder is configured
as follows:
• outer diameter [D0] = 25 mm
• inner diameter [Di] = 20 mm
• height of the hollow cylinder [h] = 500 mm
In last specification step you have to select the
material. The specific density [p] is automatically
added once the material has been selected. We
select rolled aluminum with a density of 2700 kg/m³
as material.

Results view
Once all the required data have been entered
successfully, the result is displayed in the lower
window of the inertia calculator (see image on the
left). Our hollow cylinder has a volume of 7.85E-07 m³,
a mass of 7.85E-07 kg and a mass inertia of 9.82E-08

kgcm².

Selecting the units!
All units used in the inertia calculator can be changed via pull-down menus (to the right of the input
fields). When a unit is changed, the result is shown in the result and sum view.
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Step 4

Data transfer to the settings area
Once all the data required for your hollow cylinder
have been entered and the inertia calculator has
provided the results, confirm your configuration with
OK.
After the confirmation your data are automatically
transferred to the settings area of your load case (see
image on the left).
You have successfully transferred your data into the
settings window for the Conveyor belt load case. Now
you can enter further inertia data.

5.2 The mass calculator
This section provides basic information on the mass calculator.

Detailed procedure!
The mass calculator has the same interface as the inertia calculator. 
For a detailed procedure please refer to the steps from chapter: 
“The inertia calculator [} 37]".

5.3 The progress bar
This section provides basic information on the progress bar.

The TC3 Motion Designer progress bar indicates
which menu items have already been processed and
which are still outstanding.
A processed menu item is indicated by the graphic to
the left of the menu name.
In this example (see image on the left) the menu
items load case, motion profile, transmission element
and gear unit have already been processed
successfully.
The menu items motor, controller, bill of materials
and emergency stops are not fully configured and
processed.
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6 Calculating an application
This section provides an example configuration for a 3-axis gantry based on a notional customer inquiry.

Customer requirements profile

Axes requirements:

Load case Installa-
tion posi-
tion

Total mass 
to be moved

Slope Diameter Pitch circum-
ference

Weight

X-axis Pinion rack Horizontal 350 kg (including 
Y- and Z-axis)

--- --- 200 mm 
(pinion)

---

Y-axis Toothed belt – axis Horizontal 100 kg (including 
Z-axis)

--- 80 mm 
(drive rollers)

--- 0.5 kg
(belt)

Z-axis Ball screw Vertical 50 kg 10 mm 
(spindle)

20 mm 
(spindle)

--- ---

Requirements for the motion profile:

X-axis: 
The X-axis is to move to position 1000 mm in 0.75 seconds.
Y-axis: 
The Y-axis starts at the same time as the X-axis. It should move to position 200 mm in 0.4 seconds.
Z-axis: 
The Z-axis starts once the X-axis has moved to position 750 mm. After 0.5 seconds it should move 100 mm downwards.
The entire operation should take 0.75 seconds. After 0.5 seconds the axes should move back up to the starting point.

DC link and load overview of the application
This view shows the components of the DC link for the
application.
In our customer requirements profile we now have a DC
link with the following components:
• Single-axis module AX8108 (8 A, OCT-capable,

TwinSAFE)
• Single-axis module AX8108 (8 A, OCT-capable,

TwinSAFE)
• Single-axis module AX8108 (8 A, OCT-capable,

TwinSAFE)
• AM8551-+AG2210-LP090 at pinion rack
• AM8541-+AG2210-LP090 at pinion rack
• and AM8033 with spindle drive.

The performance overview now shows graphically all
performance data for the DC link. A precisely structured
version of this view will subsequently be included in your
report.

The procedure for Creating a report [} 42] is explained in
the next section.
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6.1 Creating a report
Creating a full or short report

To create a full report proceed as follows:

• In the Solution Explorer [} 9] right-click on your TC3 Motion
Designer project.

• A new menu window opens
• In the menu window click on Create full / short report (highlighted

in yellow).

Next, select the target language for your report.
• Open the pull-down menu.
• Select your target language (German or English).
• Confirm your choice with OK.

Your report opens in a new window (see image on the left). In the
Visual Studio view you can read the full report and consider it for
your further strategy. 

To save the report as a PDF file proceed as follows:

• Click on Print button (see image on the left, area highlighted in
yellow) or use the keyboard shortcut Ctrl+P.

• Select Adobe PDF printer (1) and confirm by pressing the Print
button (2).

• A window appears that shows the progress of the PDF generation
process. The generated PDF will be saved to your selected
storage location.

Example report for customer requirements profile!
Here you can find example reports for the customer requirements profile used in this section.
Please note that both the „Full report“ and the „Short report“ are based on notional data and must
not be used for your actual application.

http://download.beckhoff.com/download/document/motion/FullReport_de.pdf
http://download.beckhoff.com/download/document/motion/FullReport_de.pdf
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7 FAQs
This section describes possible software errors and their troubleshooting.

7.1 Friction coefficient
This section provides basic information about the friction coefficient.

For each selected load case, a coefficient of friction
can be specified in the settings area (1).
The values to be entered are application-specific.
Please check your load case in advance for possible
friction areas and refer to the tables below for
approximate values.

The friction coefficient describes the relationship of the contact pressure between two bodies. A distinction is
made between sliding friction and static friction. The friction coefficient between the selected materials bust
be included in the specification of a load case.

The table below contains approximate values, which you can use for the configuration of your load case.
Please note that friction depends on several different factors, e.g.:

• material combination
• surface
• lubrication
• temperature
• moisture
• wear
• normal force

so that only guide values can be provided.

Friction coefficient for multiple bearings!
Please note a load case configuration may include several bearings. This will affect the approximate
value of your friction coefficient. For more detailed information please contact the component
manufacturer.

Static friction

Static friction is a force that prevents sliding of bodies that are in contact with each other. Static friction
creates a bond between bodies through frictional connection. In TC3 Motion Designer the static friction is
assumed to be 0.



FAQs

TE591044 Version: 1.1

Sliding friction

Sliding friction at the contact surfaces between bodies that move relative to each other. In some material
combinations creep occurs, so that the friction force becomes speed-dependent. The sliding friction force is
usually lower than the static friction force at the same normal force. The following table shows sliding friction
coefficients for different material combinations.

material combination Without lubrication With lubrication
static dynamic static dynamic

aluminum on aluminum 1.2 1.4 0.3 ---
aluminum on mild steel 0.61 0.47 --- ---
lead on cast iron --- 0.43 --- ---
bronze on cast iron --- 0.22 --- ---
bronze on steel --- --- 0.16 ---
cadmium on mild steel --- 0.46 --- ---
cadmium on cadmium 0.5 --- 0.05 ---
chromium on chromium 0.41 --- 0.34 ---
iron on iron 1 --- 0.175 ---
solid matter on rubber 2.5 --- --- ---
mild steel on mild steel 0.74 0.57 --- 0.1
mild steel on brass 0.51 0.44 --- ---
mild steel on phosphor bronze --- 0.34 --- 0.173
mild steel on lead 0.95 0.95 0.5 0.3
mild steel on cast iron --- 0.23 0.183 0.133
glass on nickel 0.78 0.56 --- ---
glass on metal 0.6 --- 0.25 ---
glass on glass 0.95 0.4 0.35 0.1
graphite on steel 0.1 --- 0.1 ---
graphite on graphite 0.1 --- 0.1 ---
cast iron on cast iron 1.1 0.15 --- 0.07
hard steel on hard steel 0.78 0.42 0.075 0.008
hard steel on graphite 0.21 --- 0.09 ---
hard steel on polystyrene 0.325 --- 0.325 ---
hard steel on polyethylene 0.2 --- 0.2 ---
magnesium on magnesium 0.6 --- 0.08 ---
brass on cast iron --- 0.3 --- ---
nickel on mild steel --- 0.64 --- 0.178
nickel on nickel 0.9 0.53 0.28 0.12
nylon on nylon 0.2 --- --- ---
platinum on platinum 1.2 --- 0.25 ---
plexiglass on plexiglass 0.8 --- 0.8 ---
plexiglass on steel 0.45 --- 0.45 ---
polyethylene on steel 0.2 --- 0.2 ---
polystyrene on steel 0.325 --- 0.325 ---
polystyrene on polystyrene 0.5 --- 0.5 ---
silver on silver 1.4 --- 0.55 ---
steel on aluminum bronze 0.45 --- --- ---
steel on brass 0.35 -- 0.19 ---
steel on cast iron 0.4 --- 0.21 ---
steel on copper alloy 0.22 --- 0.16 0.145
steel on graphite 0.1 --- 0.1 ---
steel on phosphor bronze 0.35 --- --- ---
Teflon on steel 0.04 --- 0.04 0.04
Teflon on Teflon 0.04 --- 0.04 0.04
zinc on cast iron 0.85 0.21 --- ---
zinc on zinc 0.6 --- 0.04 ---
tin on cast iron --- 0.32 --- ---
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Typical manufacturer's data for load case-dependent friction coefficients:

Load case Linear guide Ball-type linear
drive

Trapezoidal spin-
dle

Sliding bearing
sintered bronze /

steel

Gliding bearing
plastic / steel

µ1) µ1) η2) µ1) η2) µ1) η2) µ1) η2)

Conveyor belt
Rack and pinion
Rotary table
Spindle 0.001 – 0.003 0.003 0.96 0.20 0.32
Crank gear 0.001 – 0.003 0.04 – 0.12 0.10 – 0.20
Winder

1)Friction coefficient in µ and 2)efficiency in η

7.2 Inertia ratio
The inertia ratio describes the relationship between a mass and its inertia. While the mass provides
information about the weight of a body, the mass inertia (J) provides additional information about the
geometry. For drive systems, it is important that a certain ration between load mass inertia and rotor mass
inertia of the motor is not exceeded. This mass inertia ratio is referred to as lambda (λ).

The following table shows typical inertia ratio limit values.

Application Inertia ratio
High-end servo drives for maximum accuracy with maximum dynamics λ ~ 1
Typical servo drives in machine tools 1 < λ ≤ 3
Handling systems with high dynamics 3 < λ ≤ 10
Direct drives with rigid coupling between motor and load, simple applications
without specific demands in terms of positioning accuracy and dynamics

10 < λ
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7.3 Formula table
This section provides an overview of possible functions that can be used in the settings area of TC3 Motion
Designer.

Function and mathematical expression Explanation
Negative sign [neg] Numerical value or inverse function with negative sign (-)
Sine [sin] Trigonometric sine function
Cosine [cos] Trigonometric cosine function
Tangent [tan] Trigonometric tangent function
Arc sine [asin] Inverse function of the trigonometric sine function (arc function)
Arc cosine [acos] Inverse function of the trigonometric cosine function (arc function)
Arc tangent [atan] Inverse function of the trigonometric tangent function (arc function)
Hyperbolic sine [sinh] Mathematical hyperbolic function (sine)
Hyperbolic cosine [cosh] Mathematical hyperbolic function (cosine)
Hyperbolic tangent [tanh] Mathematical hyperbolic function (tangent)
Area hyperbolic sine [asinh] Inverse function of the hyperbolic sine function (area function)
Area hyperbolic cosine [acosh] Inverse function of the hyperbolic cosine function (area function)
Area hyperbolic tangent [atanh] Inverse function of the hyperbolic tangent function (area function)
Exponential function [exp / e²] Function in the form ϰ ↦ α“ based on real numbers a > 0 and a ≠ 1
Logarithm [log] The logarithm of a number describes the exponent with which a specified number 

(base) must be raised in order to obtain the required number.
Integral cosine [ceil] Function with a function rule containing an integral and the cosine function.
Absolute value [abs] Absolute numerical value
Sigmoid function [sign] This function describes a scaled and shifted hyperbolic tangent function (area function)

containing e (Euler number).
Modulo [mod] Modulo calculates the remainder (b) of a division (n) divided by m. This enables a

function in which each pair of numbers (n; m) contains an unambiguous remainder b.
Minimum value [min] Minimum possible and permissible value
Maximum value [max] Maximum possible and permitted value
Sum [sum] Result of an addition
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7.4 Error Messages
This section contains information on common error messages and troubleshooting.

Error message Cause Solution
ErrorArticleOrderCode The motors or gear units are not fully configured. Open the BOM configuration and reselect

your components.
ErrorArticlesOrderCode The motors or gear units are not fully configured. Open the BOM configuration and reselect

your components.
ErrorCableMissing Open the BOM configuration and reselect

your components.
ErrorDCLinkMaxBleeder The maximum required braking power is greater

than the maximum braking power of the DC link.
Open the performance overview of the DC
link.
Reconfigure the DC link

ErrorDCLinkMaxInfeed The maximum required feed-in power is greater
than the maximum feed-in power of the DC link.

Open the performance overview of the DC
link.
Reconfigure the DC link

ErrorDCLinkNomBleeder The effective required braking power is greater than
the nominal braking power of the DC link.

Open the performance overview of the DC
link.
Reconfigure the DC link

ErrorDCLinkNomInfeed The effectively required feed-in power is greater
than the nominal feed-in power of the DC link.

Open the performance overview of the DC
link.
Reconfigure the DC link

ErrorDriveMaxSafety The maximum load of the servo drive is too high
with the selected safety value

Select an alternative servo drive.

ErorrDriveMotorConnection The servo drive cannot be coupled with the motor. The servo drive is not compatible with the
selected motor.
Reconfigure the combination.

ErrorDriveNomSafety The nominal load of the servo drive is too high with
the selected safety value

Select an alternative servo drive.

ErrorEffectiveBrake The application requires higher effective braking
power than the DC link can absorb.

Open the performance overview of the DC
link.
Reconfigure the DC link

ErrorEffectiveInfeed The application requires higher effective feed-in
power than the DC link can provide.

Open the performance overview of the DC
link.
Reconfigure the DC link

ErrorFanIsMissing A suitable fan cover must be added for the
EL7221-9014.

Open the BOM configuration and select a
different motor.

ErrorFeatherKey A smooth motor shaft must be selected for the
motor/gear combination.

Open the BOM configuration and select a
different motor.

ErrorFeedbackConnection The selected motor feedback system is
incompatible with the selected servo drive.

Reconfigure the combination.

ErrorGearboxMaxSafety The maximum load of the gear unit is too high with
the selected safety value.

Select a different gear unit.

ErrorGearboxNomSafety The nominal load of the gear unit is too high with
the selected safety value.

Select a different gear unit.

ErrorMaximalBrake The application requires higher maximum braking
power than the DC link can absorb.

Open the performance overview of the DC
link.
Reconfigure the DC link

ErrorMaximalInfeed The application requires higher maximum feed-in
power than the DC link can provide.

Open the performance overview of the DC
link.
Reconfigure the DC link

ErrorMotorCableLength The maximum motor cable length has been
exceeded.

Adjust the motor cable length.

ErrorMotorChokeRecommendation A motor choke is recommended for the selected
cable length.

Add a motor choke.

ErrorMotorGearboxMounting The selected gear unit cannot be mounted on the
selected motor.

Select a suitable gear unit.

ErrorMotorMaxSafety The maximum load of the motor is too high with the
selected safety value.

Select a different motor.

ErrorMotorNomSafety The nominal load of the motor is too high with the
selected safety value.

Select a different motor.
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Error message Cause Solution
ErrorWarningDriveMaxSafety The maximum load of the servo drive is too high

with the selected safety value.
The servo drive is inadequately
dimensioned.
Select an alternative servo drive.

ErrorWarningDriveNomSafety The nominal load of the servo drive is too low with
the selected safety value.

Select an alternative servo drive.

ErrorWarningGearboxMaxSafety The maximum load of the servo drive is too low with
the selected safety value.

Select a different gear unit.

ErrorWarningGearboxNomSafety The nominal load of the gear unit is too low with the
selected safety value.

Select a different gear unit.

ErrorWarningMotorMaxSafety The maximum load of the servo drive is too low with
the selected safety value.

Select a different motor.

ErrorWarningMotorNomSafety The nominal load of the motor is too low with the
selected safety value.

Select a different motor.

Download error in Internet Explorer

When you try to download the TC3 Motion Designer with
the Internet Explorer browser, the following error message
may appear (see image on the left): 
“The signature of this program is corrupt or invalid”
.
In this case please download the Mozilla Firefox browser
and try again.
The error should now be fixed.
If this is not the case, please contact the Beckhoff
applications department.

Further installation steps can be found in section "Installing
TC3 Motion Designer [} 7]".

7.5 Setup under Windows
Before installing TC3 Motion Designer, please ensure that Mozilla Firefox is set as default browser.

All the required computer settings can be found in chapter: “System requirements [} 6]”.

Should you encounter unexpected problems during setup of TC3 Motion Designer, please contact the
Beckhoff applications department.

7.6 Setting the language
To change the language in TC3 Motion Designer proceed as follows:

Open the pull-down menu (1) in the top right of the
user interface.

Select your target language (German or English).
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7.7 Service packs and upgrades
Small error messages were incorporated
for the supply and brake lines in the DC
link.
They provide information about the settings
you made.
They are displayed on mouseover.

The DC link overview was revised, and the order of the
components was changed:
• The additional articles for the servo drive (AX Bridge,

safety option card, etc.) are now arranged above the
servo drive.

• Existing motor chokes are positioned directly below
the servo drives.

• Brake resistors are displayed.
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8 Support and Service
Beckhoff and their partners around the world offer comprehensive support and service, making available fast
and competent assistance with all questions related to Beckhoff products and system solutions.

Beckhoff's branch offices and representatives

Please contact your Beckhoff branch office or representative for local support and service on Beckhoff
products!

The addresses of Beckhoff's branch offices and representatives round the world can be found on her internet
pages: https://www.beckhoff.com

You will also find further documentation for Beckhoff components there.

Beckhoff Support

Support offers you comprehensive technical assistance, helping you not only with the application of
individual Beckhoff products, but also with other, wide-ranging services:

• support
• design, programming and commissioning of complex automation systems
• and extensive training program for Beckhoff system components

Hotline: +49 5246 963 157
Fax: +49 5246 963 9157
e-mail: support@beckhoff.com

Beckhoff Service

The Beckhoff Service Center supports you in all matters of after-sales service:

• on-site service
• repair service
• spare parts service
• hotline service

Hotline: +49 5246 963 460
Fax: +49 5246 963 479
e-mail: service@beckhoff.com

Beckhoff Headquarters

Beckhoff Automation GmbH & Co. KG

Huelshorstweg 20
33415 Verl
Germany

Phone: +49 5246 963 0
Fax: +49 5246 963 198
e-mail: info@beckhoff.com
web: https://www.beckhoff.com

https://www.beckhoff.com/support
https://www.beckhoff.com
https://www.beckhoff.com
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More Information: 
www.beckhoff.com/te5910
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